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1 Windows OS

1.1 Installation Options available

On a windows computer there are three options available for installing Auto Excelforms.
You may choose, in order of preference:

1. The windows installer (an executable windows .exe file)

2. Install the add-in via a standard excel workbook file

3. Manualinstallation

The first method will install the add-in and will also include the help pdf and sample data files. It will also
allow for uninstalling via the windows uninstall utility.

With the second and third methods, you will have to download the pdf help file and sample data
separately.

The third method requires manual installation.
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1.2 Windows Installer

The windows installer is a windows executable file Auto ExcelForms v1.xx.exe that will install the standard
Excel add-in, AutoWinForms.xlam along with the user documentation in a folder of your choosing. It will
register and activate the add-in with Excel so you won’t have to do this manually.

(i) Download and unzip the windows installer Auto ExcelForms vX.xx.exe
(ii) Close the Excel application if it is opened then
(iii) double click on the downloaded executable file and follow the prompts.

Windows Installer Dialog

na Setup - AutoExcelForms 1.01

Select Destination Location
Where should AutoExcelForms be installed?

Auto

EXCE' Forms Setup will install AutoExcelForms into the following folder.

To continue, click Next. If you would like to select a different folder, click Browse.

At least 3.2 MB of free disk space is required.

Cancel

You can accept the suggested folder or you can Browse to another location for the installation of the files.
You will be prompted to optionally activate the add-in or not. If you untick the box to do so you will have to
manually activate the add-in later.

Remember to ensure that within Excel, macros should be enabled.
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1.3 Installation from Excel workbook file

Auto ExcelForms can be installed by opening a standard macro-enabled Excel file: -
InstallWinForms.xIsm.

This is included in a compressed zip file which can be “unzipped” to a folder of your choosing.

The Excel installer file, InstallWinForms.xIsm, will most likely need to be unblocked since Microsoft will
usually block files with executable code that are downloaded or come from another computer. This
includes perfectly safe macro-enabled Excel workbooks.

To unblock the file:

1. Use file manager to locate the installer file
2. Right click the filename and select Properties
3. Click the unblock field so that the tick mark is displayed as below.

Unblocking the downloaded installer file
T InstallWinForms Properties X
General Security Details Previous Versions

n -, InstallWinForms

L —)

Type offile Microsoft Excel Macro-Enabled Worksheet ( xlsm)

Opens with EJ Excel Change..
Location \Downloads
Size 2.31 MB (2.430.764 bytes)

Sieondisk. 232 MB (2437120 bytes)

Created Monday. 16 September 2024, 12.26:32 pm
Modified Monday, 16 September 2024, 12:26:34 pm

Accessed Today. 16 September 2024, 12:26:34 pm

Attributes [[JRead-only [ JHidden Advanced
Security This file came from another computer —
and might be blocked to help protect £/l Unblock
this computer

Once the installation excel file is unblocked, you should close Excel if it is opened, then double click or click
and enter to launch Excel with the installer.

continued......
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Installation from Excel workbook file contd.

Click on Yes to the prompt that appears. After a short while, Excel will automatically close. When you re-

open Excel the add-in will have been installed.

Installation from Excel workbook screen:

InstallWinForms - Excel p Search .
File Home Insert Page Layout Formulas Data Review View RC Developer Help
[j X ¢ Anl===® e @ F7£'
—— Ao . P i < s g
St b B I Uv |« & Av|Z=E=Z|Z = | EMeget Cente $~ % 9| % '
Clipboard N Font § | Alignment Number
v | : =

Auto FxcelForms Installer - Windows OS

Auto ExcelForms

Windows OS Add-in

Please remember to ensure your security settings will allow
macros to run.

N.B. If you have trouble running this script you may first need to Press Yes to confirm Installation of Auto ExcelForms. No to Exit

unblock this file as well as the add-in file after downloading.

Table Starter | Install ® Y|
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Manual Installation

Auto ExcelForms is a standard Excel add-in AutoWinForms.xlam packaged in a zip file.

Unzip the file, and store the add-in in the User Add-in Library, which is
C:\Users\USERNAME\AppData\Roaming\Microsoft\AddIns\

and can be found by typing %appdata%\microsoft\addins in windows explorer

You can store the add-in in just about any folder, but when you use this default Add-In folder, it’s easier to
find the add-in from within Excel when you install it.

You may need to unblock the add-in since Microsoft will usually block programs and add-ins that are
downloaded or come from another computer.

Unblocking a downloaded file

o N

General Security Details Previous Versions

=]
S:EI ‘AutoWinForms

Type offile: Microsoft Excel Add-In { xlam)

Opens with: i Excel Change...
Location: EMAutoExcelForms
Size: 277 MB (2,912,720 bytes)

Size ondisk: 278 MB (2,920,448 bytes)

Created: Monday, 2 September 2024, 5:11:23 am
Modified: Monday, 2 September 2024, 5:11:36 am

Accessed: Today. 2 September 2024, 5:11:36 am

Atributes: [ |Read-only [ ]Hidden Advanced..

Security: This file came from another computer
and might be blocked to help protect Unblock
this computer.

OK Cancel Apply
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Click on the File tab > Options > Add-Ins to bring up the following screen:

General @ View and manage Microsoft Office Add-ins.
Formulas
Data Add-ins
Proofing . N
Name = ILocat\on IType
Save Active Application Add-ins
Language Ribbon Commander Framework add-in C:\...ommander\x64\RibbonCommander.dll ~ COM Add-in
Ribbon Commander Framework Add-in (Ul) COM Add-in
Ease of Access
Advanced Inactive Application Add-ins
Acrobat PDFMaker Office COM Addin C:\...MakenOffice\x64\PDFMOfficeAddin.dll  COM Add-in
Customize Ribbon . . . . .
Analysis ToolPak C:\...ffice16\Library\Analysis\ANALYS32.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA C:\...ice16\Library\Analysis\ATPVBAEN.XLAM  Excel Add-in
Add-ins Auto ExcelForms C:\...ng\Microsoft\AddIns\AEFWIN 1.01.xlam  Excel Add-in
Date (XML) C:\..Microsoft Shared\Smart Tag\MOFL.DLL  Action B
Trust Center Euro Currency Tools C:\...root\Office16\Library\EUROTOOL.XLAM  Excel Add-in
Inquire C:\...soft Office\Office16\DCF\NativeShim.dil  COM Add-in
Microsoft Actions Pane 3 XML Expansion Pack
Microsoft Power Map for Excel C:\...p Excel Add-imM\EXCELPLUGINSHELL.DLL COM Add-in
Microsoft Power Pivot for Excel C:\...l Add-in\PowerPivotExcelClientAddIn.dll  COM Add-in |Z|
Add-in: Ribbon Commander Framework add-in
Publisher: <None>
Compatibility: No compatibility information available
Location: C:\Program Files (x86)\Common Files\IlydaUK\RibbonCommander\x64\RibbonCommander.dll
Description: ~ Ribbon Commander Framework add-in
Manage: | Excel Add-ins ‘l | Go... _
| oK | | Cancel
Click on Go.

If you saved the add-in to the default add-in folder you should see the Auto Excelforms add-in appear in the
next screen:

ﬂ Analysis ToolPak - VBA
[] Auto ExcelForms Winos h
Cancel
:‘ Euro Currency Tools
ﬂ RibbonX Visual Designer
Solver Add-in Browse...

L\\) Automation...

Analysis ToolPak

Provides data analysis tools for statistical and engineering
analysis
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Check the box for Auto ExcelForms, then click OK, and the add-in will be installed and available whenever
you run Excel. If you installed the add-in to a different folder you will need to click Browse and select the
xlam from that location.



Auto ExcelForms

2 MACOS

2.1 Installation Options available

On a Mac OS computer there are two options available for installing Auto Excelforms.
You may choose, in order of preference:

1. Install the add-in via a standard excel workbook file

2. Manual installation

The second method can be used if you wish to install the add-in to a special folder other than the default
folder for add-ins, or if you are having difficulty with the first method.
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Installation from Excel workbook file

Auto ExcelForms can be installed by opening a standard macro-enabled Excel file: -
InstallMacForms.xIsm.

This is included in a compressed zip file which can be “unzipped” to a folder of your choosing.
Once the installation excel file is unzipped, you should close Excel if it is opened, then double click or click
and enter to launch Excel with the installer file: InstallMacForms.xIsm

1. You will be asked to enable macros for the workbook. Respond affirmatively.
2. When the install screen appears, Click on Yes to the prompt that appears.

3. After a short while, Excel will automatically close. When you re-open Excel the add-in will have
been installed.

Installation from Excel workbook screen:

Excel File Edit View Insert Format Tools Data Window Help

& InstallMacForms.xlsm

Home Insert Draw Page Layout Formulas Data  Review View Developer  Table

fﬁ] A G AT A ===y General = [ conditional Formatting v & Insert v
TR === [iZ Format as Table v T% Delete v
Paste i e 0, «0 .00 s
& O v A il =5 v $ v % 9 .00 =0 Cell Styles [i] Format v
Clipboard Font Allgnment Number Styles Celis

a“r»

1

Auto FxcelForms Installer - Mac OS

Auto ExcelForms
Mac OS Add-in

Please remember to ensure your security settings will allow
macros to run.

N.B. During installation, you may need to grant access to a file or
folder due to Mac OS sandboxing.

Table Starter & Install

Ready 1T :
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Manual Installation

Auto ExcelForms for Mac is a standard Excel add-in AutoMacForms.xlam packaged in a zip file.
Unzip the downloaded file to extract the Excel addin. Open a Finder window to search for the add-ins folder
and extract the file to this location.

®0® < Add-Ins g8 E=8 [0 | &3 s

Name
@ Recents @ AutoMacForms.xlam
4 Applications
Desktop
(® Documents
© Downloads
{a} newuser

@) AirDrop
5 Add-Ins

Open Excel.
From the top-level Mac menubar, click the Tools menu and select Excel Add-ins. This will open the Add-ins
dialog.

Excel File Edit View Insert Format Tools Data Window Help

B - Spelling...
Thesaurus. L3R
[ Calibri (Body) v 12« A, SmartLookup.. #L rapText v General v @ \
Paste ’ B I U Hv A tanquee v 9 €0 .00 Conditior
a4 vy == ¥ AutoCorrect Options... g & Centery $v% 9 00 =30 Eormattit
Clipboard Font Error Checking.“ Number

Al19 2 )
v L . Translate...

Check Accessibility

16 Track Changes >

Protection >
19
"
Goal Seek...

2 Scenarios...
23 Auditing >

Macro >

26
2

28 Customize Keyboard...
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Browse to the add-ins folder and select the Auto ExcelForms add-in you extracted, select it, and click Open.

BB -
Home Insert Draw Pagelayout Formulas Data Review View Developer # share
I 4 cx == s b = A i
v Calibri (Bod v 12 v = = = B v 252 wrap Text v General v v v v v v v o M v
[* tBoc) (58 | 7|t veeTe [El- Bz~ - &8 =-=- 200y SiS
Paste U - o o Ao == g % Sl €0 00 Conditional Format  Cell insert  Deleta  Format Sort& Find & Add-ins
g BoU o - == Mergeh Caoter TR 00 30 | Formatting as Table Styles & v Fiter Select
clipboard Font Alignay Add-ins Styles cells Editing Add-Ins
A19 . I v
| Add-ins available: |
A A B G D 3 F G 54_ E 0 P a R s T u v
14 1 Analysis ToolPak I
15 | Solver Add-In
16
17
18
—
21 i Analysis ToolPak
22 . - o
= Provides data analysis tools for statistical and
= engineering analysis
25 1 [
26 | |
27 |
2% # Pron e P e C
29
20 Favorites =, m. = Add-Ins e a
a " . @ Recents
n
33 I & Applicati... Previous 7 Days Size Kind Date A
34 i

e | = Deskiop &% AutoMacForms.xlam h 2AMB  Microso...(xlam) 22Aug

3? [ Documents
38 | © Downloads
33 I
40 | fa} newuser
a1
= | B3 Add-ins
4
4 | Media
s :
- i S Music
a | (3 Photos
a8 q
a9 | B Movies
50 I
51 l Tags
52
53
Sheet1 + —| I3
Ready 1T L

A window allowing you to select the Add-in will appear.
Click OK
Add-ins

Add-ins available:

Analysis ToolPak
Auto ExcelForms Mac Os
Solver Add-In

Auto ExcelForms Mac Os

Instantly enhance your data with highly
Customizable, professional user forms and much
more

Browse... Cancel




